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1 Einleitung 

Mit dem PCAN-Diag können verschiedene Eigenschaften eines 
CAN-Busses im mobilen Einsatz analysiert werden. Zum einen sind 
Messungen der Übertragungsrate, der Buslast und der Terminie-
rung am CAN-Bus während des CAN-Betriebs möglich. Zum ander-
en steht eine Oszilloskopfunktion zur Verfügung, die das differen-
zielle CAN-Signal mit zwei Kanälen darstellt und verschiedene 
Triggerereignisse berücksichtigt. Ein CAN-Frame lässt sich anhand 
des aufgezeichneten Signalverlaufs dekodieren. Auf der Protokoll-
ebene ist die Darstellung des CAN-Verkehrs als Liste, bei Bedarf 
auch in symbolischer Form möglich. Umgekehrt kann eine Sende-
liste für CAN-Nachrichten eingerichtet werden. 

Die Bedienung erfolgt anhand eines Drehtasters. 

Neben dem standardmäßig vorhandenen High-Speed-CAN-
Transceiver ist das Gerät auch mit Transceivern für weitere CAN-
Übertragungsstandards lieferbar. 

1.1 Eigenschaften im Überblick 

 High-Speed-CAN ISO 11898-2, Transceiver für weitere CAN-
Übertragungsstandards auf Anfrage 

 CAN-Anschluss D-Sub 9-polig 

 OLED-Display mit 320 x 240 Pixeln 

 Spannungsversorgung mit Batterien/Akkus oder mit mitgeliefer-
tem Steckernetzteil (keine Ladefunktion für eingelegte Akkus) 

 Senden von CAN-Nachrichten oder Nachrichtenlisten 
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 Symbolische Darstellung empfangener CAN-Nachrichten mit 
Hilfe von CAN-Definitionsdateien 

 Messung der Buslast 

 Messung der Terminierung am High-Speed-CAN-Bus  
(während des Betriebs) 

 Spannungsmessung für CAN-Leitungen 

 Oszilloskopfunktion für CAN-Signale mit 2 Kanälen und einer 
Abtastfrequenz von 20 MHz pro Kanal 

 Verschiedene Trigger-Möglichkeiten (u. a. CAN-ID oder Error-
Frame) 

 Dekodierung von CAN-Nachrichten anhand des aufgenomme-
nen Signalverlaufs 

1.2 Lieferumfang 

 PCAN-Diag 

 Kunststoffkoffer für das Gerät und für Zubehör 

 4 Batterien 1,5 V Mignon/AA 

 Steckernetzteil 

 CD mit Software und Dokumentation 
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2 Inbetriebnahme 

Gehen Sie für die Inbetriebnahme des PCAN-Diag die Abschnitte in 
diesem Kapitel der Reihe nach durch. 

2.1 CAN-Anschluss (D-Sub) 

Je nach Transceiver-Ausstattung des PCAN-Diag unterscheidet sich 
die Belegung des 9-poligen D-Sub-Steckverbinders. 

 
Anschlussbelegung bei Bestückung mit High-Speed-Transceiver (Standard)  

oder Low-Speed-CAN-Transceiver 

 
Anschlussbelegung bei Bestückung mit Single-Wire-CAN-Transceiver  

(zusätzliche Hinweise im Text unten) 

Bei der Ausstattung des PCAN-Diag mit Single-Wire-CAN-Trans-
ceiver muss über Pin 1 die zusätzliche Versorgung des Transceivers 
stattfinden. Die Versorgungsspannung liegt im Bereich von 7 bis 
19 Volt (z. B. von der Autobatterie). 
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Die Masse (GND) an den Pins 3 und 6 kann in den Geräteeinstel-
lungen (Device Settings  > D-Sub GND connection) zu- oder 
abgeschaltet werden. Siehe auch Abschnitt 2.5.4 Seite 16. 

Die Anschlussschirmung ist geräteintern mit der Masse (GND) 
verbunden. 

Für eine gesonderte Masseverbindung zu anderen CAN-Knoten 
oder Messobjekten steht an der Geräterückseite eine Massebuchse 
(4 mm) zur Verfügung. Die interne Masseverbindung ist dauerhaft. 

 
Massebuchse (4 mm) an der Geräterückseite 

2.2 Spannungsversorgung 

Für das PCAN-Diag gibt es zwei Möglichkeiten der 
Spannungsversorgung: 

 extern über die Versorgungsbuchse (Abschnitt 2.2.1) 

 vorübergehend mit Batterien oder Akkus (Abschnitt 2.2.2) 

Während des Betriebs wird der Status der Spannungsversorgung 
oben rechts auf dem Bildschirm dargestellt (Abschnitt 2.4). 

Hinweis: Eingelegte Akkus werden bei externer Spannungsver-
sorgung nicht aufgeladen. 
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2.2.1 Versorgungsbuchse 

Zur Versorgung über die entsprechende Buchse an der Geräterück-
seite können Sie das mitgelieferte Steckernetzteil oder eine 
alternative Gleichspannungsquelle verwenden. 

 
Versorgungsbuchse an der Geräterückseite  
für den Anschluss mit einem Hohlstecker 

  
Versorgungsspannung:  

12 V DC (8 - 50 V möglich) 
Durchmesser des Hohlsteckers:  

a = 5,5 mm, b = 2,1 mm;  
Mindestlänge: 11 mm 

2.2.2 Batterien/Akkus 

Für den mobilen Einsatz ist die Versorgung mit Batterien oder Akkus 
möglich: 

 Größe: Mignon/AA 

 Anzahl: 4 

 Einzelspannung: nominell 1,2 V (Akkus) oder 1,5 V (Batterien) 

Das Batteriefach befindet sich an der Gehäuseunterseite. Der Deckel 
ist mit zwei Schrauben gesichert. 



PCAN-Diag – Benutzerhandbuch 
 

10 

 
Positionen der Schrauben für Batteriefachdeckel  

(zweite Schraube unterhalb der Gummimanschette) 

Wenn eine externe Versorgungsspannung am Gerät angeschlossen 
ist, wird diese bevorzugt verwendet. Batterien oder Akkus können 
im Gerät bleiben. 

Hinweis: Eingelegte Akkus werden bei externer Spannungsver-
sorgung nicht aufgeladen. Zum Aufladen entnehmen Sie bitte 
die leeren Akkus und verwenden Sie ein gesondertes Ladegerät 
(nicht im Lieferumfang enthalten). 
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2.3 Bedienung mit dem Drehtaster 

Die Bedienung des PCAN-Diag erfolgt mit dem Drehtaster. 

Drehen: 
Auswahl verschieben; 
Funktionswert 
verändern 

 

Drücken: 
Gerät einschalten; aus-
gewählte Funktion aus-
führen; aktuelle Funk-
tion verlassen 

2.3.1 Gerät einschalten 

Drücken Sie den Drehtaster mindestens eine halbe Sekunde lang. 

Es erscheint vorübergehend ein Startbild und im Anschluss das 
Hauptmenü. 

  

Um das Gerät wieder auszuschalten, wählen Sie im Hauptmenü den 
Eintrag Power Off . 

Um beim Transport des Geräts ein versehentliches Einschalten und 
dadurch das vorzeitige Entladen von eingelegten Batterien zu ver-
hindern, können Sie auf der Rückseite des Geräts eine Schaltsperre 
für den Drehtaster aktivieren. 
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Taster für die Jog-Dial-Schaltsperre an der Geräterückseite 

Zum Aktivieren der Schaltsperre drücken Sie bei ausgeschaltetem 
Gerät den Taster mit einem schmalen Gegenstand. Das Gerät 
reagiert nun nicht mehr auf das Drücken des Drehtasters. 

Um die Schaltsperre wieder aufzuheben drücken Sie den Taster 
erneut. 
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2.4 Statusanzeige 

Bei eingeschaltetem Gerät wird rechts oben auf dem Bildschirm der 
Status der Spannungsversorgung und der CAN-Kommunikation 
angezeigt. Die Symbole haben folgende Bedeutung: 

Symbol Bedeutung 

 Eine externe Spannungsquelle (z. B. das mitgelieferte Steckernetzteil) 
ist an der Spannungsversorgungsbuchse angeschlossen. 

 
 
 
 

Das Gerät wird von den eingelegten Batterien oder Akkus versorgt. 
Die Füllstandssymbole zeigen die ungefähre Restkapazität an. 

T  R CAN-Verkehr: T = Transmit (Senden), R = Receive (Empfangen) 
Blinken: Aus-/eingehende CAN-Nachrichten 
Grün: Fehlerloses Senden/Empfangen 
Gelb, rot: Fehler beim Senden/Empfangen 

act 
pas 
off 

Informiert über den Fehlerzustand des CAN-Controllers in Bezug auf 
den angeschlossenen CAN-Bus (active, passive, bus off). Wenn 
aufgrund zu vieler Fehler der Bus-Off-Zustand erreicht ist, werden 
keine CAN-Nachrichten mehr empfangen oder gesendet. Führen Sie 
in diesem Fall nach Behebung des Fehlers auf dem CAN-Bus ein 
Reset des CAN-Controllers durch, z. B. in der Empfangsübersicht 
(Receive) mit Rst  oder in der Sendeübersicht (Transmit) mit Reset . 

L Das Gerät befindet sich im Beobachtungsmodus (Listen-only). Siehe 
Abschnitt 2.5.3 Seite 16. 
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2.5 Geräteeinstellungen 

Wählen Sie im Hauptmenü den Eintrag Device Settings . In dem 
entsprechenden Menü können Sie Einstellungen des PCAN-Diag 
anpassen, die im Folgenden erläutert werden. 

Nachdem Sie die Einstellungen geändert haben, legen Sie diese 
dauerhaft mit Save&OK  fest. Falls Sie nur vorübergehend (bis zum 
nächsten Ausschalten des Geräts) mit den geänderten Einstellungen 
arbeiten möchten, wählen Sie nur OK . Beim nächsten Einschalten 
des Geräts sind dann wieder die vorherigen Einstellungen aktiv. 

Tipp: Sie können über den Hauptmenüeintrag Profiles  alle 
Geräteeinstellungen gemeinsam für verschiedene Anforderun-
gen in Profilen abspeichern und bei Bedarf wieder aktivieren. 
Siehe auch Kapitel 3 Seite 18. 

2.5.1 CAN-Übertragungsrate 

Falls Sie die Übertragungsrate des CAN-Busses, an den das PCAN-
Diag angeschlossen ist, nicht kennen, können die Übertragungsrate 
automatisch mit Detect CAN bitrate  ermitteln lassen. Falls kein 
Datenverkehr auf dem CAN-Bus vorhanden ist, funktioniert die 
automatische Ermittlung nicht. 

Die manuelle Einstellung erfolgt mit CAN bitrate . Hier können Sie 
aus einer Liste von Standard-CAN-Übertragungsraten wählen. 

Für eine Anpassung an spezifische Verhältnisse auf dem CAN-Bus 
besteht für Experten auch die Möglichkeit, die Bus-Timing-Register 
BTR0 und BTR1 des CAN-Controllers direkt zu beeinflussen. Wählen 
Sie dazu unter CAN bitrate  den Eintrag User  aus und geben Sie 
im Feld User CAN bitrate (hex)  einen 2-Byte-Wert (4 Hexadezi-
malstellen) an, der in die Register geschrieben wird. 
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Hinweis: Die CAN-Dekodierung in der Oszilloskopfunktion des 
PCAN-Diag funktioniert nicht für benutzerdefinierte CAN-
Übertragungsraten. 

Nähere Information zur Festlegung der CAN-Übertragungsrate per 
Bus-Timing-Register erhalten Sie auf Anfrage (Kontaktdaten: siehe 
Seite 2). 

2.5.2 CAN-Terminierung 

Ein High-Speed-CAN-Bus muss an beiden Enden jeweils mit einem 
Abschlusswiderstand von 120 Ω terminiert sein. Falls Sie das PCAN-
Diag an einem Ende eines CAN-Busses anschließen, der noch nicht 
vollständig terminiert ist, können Sie mit CAN termination  einen 
internen Abschlusswiderstand zuschalten. 

Hinweis: Diese Funktion steht nur einem Geräte zur Verfügung, 
das mit einem High-Speed-CAN-Transceiver ausgestattet ist. 

 Off : Der High-Speed-CAN-Bus ist bereits korrekt an beiden 
Enden terminiert und das Gerät wird an einem Abgriff am CAN-
Bus angeschlossen. 

 On : Das Gerät wird am Ende eines CAN-Busses angeschlossen, 
der noch nicht vollständig terminiert ist. 

Tipp: Wenn Sie überprüfen wollen, ob ein angeschlossener 
High-Speed-CAN-Bus korrekt terminiert ist, können Sie die 
Messfunktion für die CAN-Bus-Terminierung verwenden: 
Measurements  > CAN Termination  (siehe auch Abschnitt 5.2 
Seite 29) 
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2.5.3 Beobachtungsmodus (Listen-only mode) 

Soll das Gerät den Datenverkehr auf dem CAN-Bus nicht beeinflus-
sen, also als reiner Beobachter eingesetzt werden, können Sie es in 
einen Beobachtungsmodus, den sogenannten Listen-Only-Modus 
versetzen (Listen-only mode  = On). So antwortet das Gerät nicht 
auf eingehende CAN-Nachrichten mit einer Bestätigung 
(Acknowledge) und sendet keine Error-Frames. 

2.5.4 Masse am CAN-Anschluss 

Die Verbindung der Gerätemasse zur Masse des zu überprüfenden 
CAN-Busses ist in manchen Fällen nicht sinnvoll. So können bei der 
Oszilloskopfunktion Probleme bei der Signalfindung wegen zu 
hohem Potentialunterschied zwischen den Massen auftreten. 

Entsprechend können Sie die Masse vom D-Sub-Anschluss für den 
CAN-Bus per Software abklemmen. Stellen Sie dazu den Eintrag 
D-Sub GND connection  auf Off . Die Einstellung betrifft gemein-
sam die Pins 3 und 6 des D-Sub-Anschlusses (Belegungsübersicht: 
siehe Seite 7). Die Anschlussabschirmung ist dauerhaft mit der 
Gerätemasse verbunden. 

2.5.5 Batteriekapazität sparen 

Falls Sie das PCAN-Diag mit Batterien oder Akkus betreiben, kann 
Batteriekapazität gespart werden, indem sich das Gerät nach einer 
einstellbaren Dauer der Nichtbenutzung automatisch ausschaltet. 
Die Dauer stellen Sie im Eintrag Shutdown time (battery)  ein. 
Bei der Einstellung Never  bleibt das Gerät dauerhaft eingeschaltet. 

Beim Betrieb mit externer Versorgung, z. B. mit dem mitgelieferten 
Steckernetzteil, bleibt das Gerät eingeschaltet, unabhängig von der 
Einstellung der Ausschaltfunktion. 
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2.5.6 Bildschirmschoner 

Die Helligkeit der Anzeige wird nach einer einstellbaren Dauer der 
Nichtbenutzung reduziert. Die Dauer stellen Sie im Eintrag 
Screensaver timeout  ein. 

2.5.7 Signaltöne 

Das PCAN-Diag kann zu diversen Ereignissen Signaltöne ausgeben. 
Diese Funktion wird mit dem Eintrag Beeper  ein- oder 
ausgeschaltet. 
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3 Einstellungen mit Profilen 
verwalten 

Um das PCAN-Diag schnell auf eine andere Einsatzumgebung 
anzupassen, können Einstellungen aus einem zuvor gespeicherten 
Profil geladen werden. Das PCAN-Diag hat dazu fünf Speicherplätze. 

Folgende Einstellungen werden in Profilen berücksichtigt: 

 Geräteeinstellungen 

 Einstellungen für Messungen am D-Sub-Anschluss 

 Oszilloskopeinstellungen 

Der Zugriff auf die Profile erfolgt über den Hauptmenüpunkt 
Profiles . Profile werden im geräteinternen Speicher abgelegt. 

Hinweis: Symboldefinitionen für CAN-Daten werden unabhän-
gig von den Profilen für die Einstellungen verwaltet. Siehe auch 
Abschnitt 4.2 Symbolische Anzeige von CAN-Daten Seite 20. 
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4 CAN-Daten empfangen und 
senden 

Das PCAN-Diag kann sowohl alle CAN-Nachrichten anzeigen, die 
auf dem angeschlossenen CAN-Bus übertragen werden, als auch 
selbst eingerichtete CAN-Nachrichten versenden. Die Darstellung 
der Nachrichteninhalte erfolgt entweder hexdezimal oder 
symbolisch. Die Symboldefinitionen werden über den CAN-Bus 
übertragen. 

4.1 Einfache Anzeige von CAN-Nachrichten 

Die einfache Anzeige von eingehenden CAN-Nachrichten erreichen 
Sie über CAN Data  > Receive Messages . Die Darstellung der 
CAN-Daten erfolgt im Hexadezimalformat. 

Eingehende CAN-Nachrichten werden in der Liste sortiert nach 
CAN-ID angezeigt. Sie können die Sortierung beeinflussen, indem 
Sie CAN-Nachrichten anklicken. Dadurch werden diese priorisiert, 
das heißt an den Listenanfang gestellt. Priorisierte Nachrichten sind 
orange gekennzeichnet. Sie können die Priorisierung durch einen 
erneuten Klick auf eine entsprechende CAN-Nachricht wieder 
zurücknehmen. 

Weitere Funktionen: 

Funktion Erläuterung 

Rst Leert die Liste der eingehenden CAN-Nachrichten und führt ein Reset 
des CAN-Controllers aus. Letzteres kann im Fall von CAN-Fehlern 
sinnvoll sein. 

Tx1  … Tx7  Aktiviert die ausgewählte Sendeliste. Die untere Statuszeile zeigt 
Information zur jeweiligen Sendeliste. Sendelisten werden über das 
Menü CAN Data  > Manage Transmit Lists  verwaltet. 
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4.2 Symbolische Anzeige von CAN-Daten 

Um die Daten eingehender CAN-Nachrichten in symbolischer Form 
darzustellen, müssen zuvor die Symboldefinitionen auf einem PC 
erzeugt und dann per CAN auf das PCAN-Diag geladen werden. 

Voraussetzungen für die Bereitstellung von Symboldefinitionen auf 
dem PCAN-Diag: 

 Computer mit CAN-Interface der PCAN-Reihe (z. B. PCAN-USB) 

 CAN-Verkabelung mit korrekter Terminierung 

 Windows 7/Vista/XP (32/64-Bit) 

 PPCAN-Editor für Windows (Installationsdatei ist auf der 
mitgelieferten CD enthalten) inkl. Hardwareprofil für PCAN-Diag 

4.2.1 Symboldefinitionen auf dem PC erstellen 

Symboldefinitionen werden im PPCAN-Editor in einer sogenannten 
Konfiguration angelegt. Die Vorgehensweise wird anhand einer 
kleinen Beispielkonfiguration mit folgenden Eigenschaften gezeigt: 

Eigenschaft Wert 

CAN-ID (hex) 300 

Symbolname DemoMessage 

Datenlänge (DLC) 2 Bytes 

Daten (Variablen) Meter (8 Bits) 
Switch1 (1 Bit) 
Switch2 (1 Bit) 

 

So erzeugen Sie eine Konfiguration mit der Symboldefinition im 
PPCAN-Editor: 

1. Wählen Sie den Menüpunkt File > New (alternativ: ). 

Das Fenster CAN Objects mit der Registerkarte General 
erscheint. 
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2. Wählen Sie auf der Registerkarte General den Eintrag Bus_0 
und dann den Menüpunkt CAN Objects > 
Add a new Symbol (alternativ: ). 

Ein neuer Eintrag Symbol1 erscheint in der Baumstruktur. 

3. Passen Sie den Eintrag an, indem Sie die einzelnen Felder 
anklicken und die Werte entsprechend den Beispielangaben 
eingeben. Achten Sie darauf, dass der Eintrag aktiviert ist 
(Häkchen bei Enable). 

 

4. Wählen Sie den Menüpunkt CAN Objects > 
Add a new Variable (alternativ: ). 

5. Passen Sie den neuen Eintrag Var1 an (Variable Meter). 

6. Wiederholen Sie die vorherigen beiden Schritte für die 
anderen Variablen. 

 

7. Wählen Sie den Menüpunkt Edit > New Configuration 
(alternativ: ) und dann aus der sich öffnenden Liste den 
Eintrag $1A: PCAN-Diag. Bestätigen Sie die Auswahl mit OK. 

Im Fenster CAN Objects wird die Registerkarte Config0 I/O 
hinzugefügt. 

8. Klicken Sie auf den Reiter der Registerkarte Config0 I/O und 
geben Sie einen beliebigen Namen für die Konfiguration an 
(Beispiel: Diag Example). 
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9. Wählen Sie auf der Registerkarte General den Eintrag Bus_0, 
dann den Menüpunkt CAN Objects > 
Add Bus to Configuration und aus der sich öffnenden Liste 
den Eintrag Diag Example I/O. Bestätigen Sie die Auswahl 
mit OK. 

10. Aktivieren Sie auf der Registerkarte Diag Example I/O den 
Symboleintrag DemoMessage und die Variableneinträge 
(jeweils Häkchen bei Enable). 

 

Hinweis: Die Einstellungsmöglichkeiten für Symbol- und 
Variableneinträge sind jeweils sichtbar, wenn ein Eintrag der 
entsprechenden Kategorie ausgewählt ist. 

11. Optional: Speichern Sie über File > Save (alternativ: ) die 
Konfiguration für die spätere Weiterverwendung auf einem 
Datenträger. 

4.2.2 Symboldefinitionen auf das PCAN-Diag laden 

Symboldefinitionen werden per CAN auf das PCAN-Diag geladen. 
Dazu wird auf der PC-Seite der PPCAN-Editor verwendet, mit dem 
Sie zuvor eine Konfiguration mit Symboldefinitionen erstellt oder 
geöffnet haben. 

So laden Sie die Symboldefinitionen auf das PCAN-Diag: 

1. Wählen Sie auf dem PCAN-Diag CAN Data  > 
Manage Symbol Files . 
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Es werden drei Listeneinträge angezeigt, die jeweils mit 
Symboldefinitionen belegt werden können. 

2. Klicken Sie für einen der drei Listeneinträge auf Load , um 
den Übertragungsvorgang per CAN seitens des PCAN-Diag 
zu initiieren. 

Das PCAN-Diag zeigt nun an, dass es auf eine Konfiguration 
vom PPCAN-Editor wartet. 

3. Stellen Sie beim PPCAN-Editor sicher, dass er eine 
Verbindung zum CAN-Bus hat (Anzeige in der Statuszeile 
unten links, in der Abbildung ein Beispiel). 

 

4. Wählen Sie in der Werkzeugleiste aus der Dropdownliste die 
Konfiguration Diag Example. 

 

5. Wählen Sie den Menüpunkt Transmit > Send Configuration 
(alternativ: ). 

Die Übertragung beginnt und dauert ein paar Sekunden. Im 
Display des PCAN-Diag erscheint „Receiving configuration“. 

6. Wenn die Übertragung beendet ist, klicken Sie beim PCAN-
Diag auf OK . 

Der zu Beginn gewählte Eintrag enthält nun die 
Symboldefinition Diag Example. 

7. Aktivieren Sie den Eintrag Diag Example durch Setzen des 
blauen Kreuzchens, um die Symboldefinition in der 
Empfangsliste anzuwenden. 
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4.2.3 Ansicht für die symbolische Anzeige aufrufen 

Für die symbolische Anzeige von CAN-Daten wird abweichend von 
der einfachen Anzeige eine gesonderte Ansicht verwendet, die Sie 
über CAN Data  > Receive Msgs. as Symbols  erreichen. Zuvor 
müssen Sie eine Symboldatei auf das PCAN-Diag geladen und 
aktiviert haben (siehe vorherige Unterabschnitte). 



PCAN-Diag – Benutzerhandbuch 
 

25 

4.3 CAN-Nachrichten senden 

Sie können bis zu 15 Sendelisten (Transmit Lists) mit einer oder 
mehreren CAN-Nachrichten erstellen. Sendelisten können entweder 
zyklisch oder auf Anforderung abgearbeitet werden. Innerhalb einer 
Sendeliste besteht die Möglichkeit, die einzelnen CAN-Nachrichten 
mit zeitlichem Versatz zu senden. 

4.3.1 Sendelisten erstellen 

So erstellen Sie eine oder mehrere Sendelisten: 

1. Wählen Sie CAN Data  > Manage Transmit Lists . 

Sie sehen eine Übersicht der zur Verfügung stehenden 
Sendelisten. 

2. Geben Sie einen Eintrag unter Transmit list  durch 
Anklicken des Kästchens frei. 

Ein freigegebener Eintrag ist mit einem Kreuzchen [X]  
gekennzeichnet. Dies bedeutet, dass zum einen die 
Eigenschaften des Eintrags geändert werden können und 
zum anderen diese Sendeliste zum Senden zur Verfügung 
steht. 

3. Klicken Sie auf den Namen rechts daneben. Wenn der 
Eintrag noch nicht belegt ist, lautet der Name unused . 

Es erscheint die Ansicht zum Editieren der ausgewählten 
Sendeliste. 

4. Ändern Sie den Namen der Sendeliste, indem Sie auf den 
Namen klicken. 

5. In der Sendeliste ist bereits ein Eintrag vorhanden. Mit den 
Kürzeln EID  rechts daneben können Sie die folgenden 
Aktionen ausführen: 
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Kürzel Aktion Erläuterung 

E Edit (Ändern) Zeigt eine Ansicht mit den Eigenschaften der 
CAN-Nachricht, um diese verändern zu 
können. 

I Insert (Einfügen) Fügt an der Stelle der Liste eine neue CAN-
Nachricht ein. Dabei werden die 
Eigenschaften der aktuellen CAN-Nachricht 
kopiert. 

D Delete (Entfernen) Löscht die CAN-Nachricht aus der Sendeliste. 
 

Wenn Sie die Eigenschaften einer CAN-Nachricht anpassen, 
steht zusätzlich zu den üblichen Eigenschaften der Eintrag 
Offset  zur Verfügung. Dieser gibt eine Dauer in Millisekun-
den an, nach der die CAN-Nachricht gesendet wird. Der 
Offset bezieht sich auf den Sendezeitpunkt der vorherigen 
CAN-Nachricht der Sendeliste, ist also eine relative Angabe. 

6. Beachten Sie unterhalb der Sendeliste die Angabe 
Min. required cycle time . Diese gibt die minimal 
mögliche Zykluszeit für die Sendeliste an. 

Die Zykluszeit für eine Sendeliste geben Sie später in der 
Übersicht aller Sendelisten an. 

7. Bestätigen Sie vorgenommenen Änderungen an der 
Sendeliste mit OK . 

8. Geben Sie in der Spalte Cycle time  die Zykluszeiten für 
die einzelnen Sendelisten an. Eine Zykluszeit von 0 ms 
bedeutet, dass die Sendeliste nur manuell ausgeführt wird. 

Hinweis: Falls Sie eine Zykluszeit angeben, die kleiner ist als die 
oben erwähnte Mindestzeit, werden nicht alle CAN-Nachrichten 
einer Sendeliste gesendet. 

9. Nachdem Sie die gewünschten Sendelisten angelegt und 
freigegeben haben scrollen Sie bis zum Ende der Übersicht 
und verlassen diese mit OK . 
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4.3.2 Sendelisten verwenden 

Gehen Sie folgendermaßen vor, um die CAN-Nachrichten einer 
Sendeliste zu senden: 

1. Wählen Sie CAN Data  > Transmit Messages . 

In der Ansicht erscheinen alle freigegebenen Sendelisten. 

2. Klicken Sie auf die gewünschte Sendeliste, um diese zu 
aktivieren. 

Eine Sendeliste mit Zykluszeit erscheint darauf hin orange. 
Sie wird solange zyklisch gesendet, bis sie durch einen 
weiteren Klick wieder deaktiviert oder das Gerät  aus- und 
wieder eingeschaltet wird. 

Eine Sendeliste ohne Zykluszeit wird nur einmalig gesendet. 
Sie ist immer orange dargestellt. 

Tipp: Alternativ können Sie auch in der einfachen Empfangs-
ansicht (CAN Data  > Receive Messages) die ersten sieben 
Sendelisten (Tx1  bis Tx7) zum Senden aktivieren. 
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5 Messungen am CAN-Bus 
durchführen 

5.1 Buslast 

Erreichbar über: Measurements  > Bus Load  

Die prozentuale Auslastung des CAN-Busses mit CAN-Nachrichten 
wird in einem Graph über einem Zeitraum dargestellt und dabei 
fortwährend aktualisiert. 

Der Graph setzt sich aus Abtastintervallen zusammen, deren Dauer 
sich aus der eingestellten CAN-Übertragungsrate und der 
angegebenen Anzahl Abtastwerte (Samples) ergeben. 

Pro Abtastintervall wird der Durchschnitts- und der Maximalwert 
der Buslast ermittelt und als Balken angezeigt. 

Sie können einer hohen Buslast entgegenwirken, indem Sie 

 die CAN-Übertragungsrate der beteiligten CAN-Knoten am Bus 
gemeinsam erhöhen oder 

 die Zykluszeit von bestimmten Nachrichten im CAN-Netz 
vergrößern um das Aufkommen zu verringern (weniger CAN-
Nachrichten pro Zeit). 
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5.2 Terminierung des CAN-Busses 

Erreichbar über: Measurements  > CAN Termination  

Hinweis: Diese Funktion steht nur bei einer Ausstattung des 
PCAN-Diags mit einem High-Speed-CAN-Transceiver zur 
Verfügung. 

Ein High-Speed-CAN-Bus (ISO 11898-2) muss an beiden Enden mit 
jeweils 120 Ω zwischen den CAN-Leitungen CAN_L und CAN_H 
terminiert sein. Mit dieser Maßnahme werden Signalreflektionen an 
den Leitungsenden vermieden und es wird eine korrekte Funktion 
der CAN-Transceiver am CAN-Bus gewährleistet. 

Aus den beiden parallel geschalteten Terminierungswiderständen 
ergibt sich ein Gesamtwiderstand von 60 Ω. Die Messung des 
Gesamtwiderstands gibt Aufschlüsse, ob der CAN-Bus korrekt 
terminiert ist. 

Messung Interpretation 

~ 60 Ω Die Terminierung am CAN-Bus ist messtechnisch in Ordnung. 
Stellen Sie sicher, dass die Terminierungswiderstände an den 
Busenden vorhanden sind und nicht zum Beispiel an Abgriffen in der 
Busmitte. 

~ 120 Ω Es ist nur ein Terminierungswiderstand vorhanden. 
Installieren Sie einen weiteren 120-Ohm-Widerstand am anderen 
Busende. 

< 45 Ω Es sind zu viele Terminierungswiderstände am CAN-Bus vorhanden. 
Dies kann zum Beispiel vorkommen, wenn an einem Busende sowohl 
ein gesonderter Terminierungswiderstand als auch ein CAN-Knoten 
mit interner Terminierung vorhanden ist. 
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5.3 Spannungen am D-Sub-Anschluss 

Erreichbar über: Measurements  > D-Sub Connector 

Die Spannungen an den einzelnen Pins des D-Sub-Steckers können 
für eine grobe Einschätzung dargestellt werden. 

Hinweis: Durch eine technisch bedingte Verzögerung bei der 
Spannungsmessung können keine vorübergehenden 
Spannungsausschläge erkannt werden. 

Sie können die Darstellung für jeden Pin konfigurieren (Settings): 

 Pin-Name (Name) 

 Anzeige eines Spannungswertes an oder aus (Enable) 

 Bereich für gültige Spannungswerte pro Pin (Min /Max). Die 
Angabe ist nur zur Anzeige bestimmt und hat keine funktionelle 
Bedeutung (außer Warnton). 

 Erzeugung eines Warntons (Alarm), falls der Messwert den 
angegebenen Spannungsbereich verlässt (nicht bei kurzzeitigen 
Spannungsausschlägen). Die Geräteeinstellung für Signaltöne 
(Beeper) muss aktiviert sein. 
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6 Oszilloskopfunktion 

Mit dem PCAN-Diag können Sie sich den Signalverlauf auf den 
CAN-Leitungen CAN_L und CAN_H oder der CAN-Leitung CAN_SW 
anzeigen lassen. Die Handhabung der Oszilloskopfunktion ist 
vergleichbar mit der eines handelsüblichen Speicheroszilloskops. 

Verschiedene Hilfsfunktionen stehen zur Verfügung, um die 
Interpretation des Signals zu erleichtern: 

 Triggern auf CAN-Frames 

 Messung eines Zeitintervalls mit Cursors 

 Dekodierung des Signalverlaufs 

Die Oszilloskopfunktion erreichen Sie über den Hauptmenüpunkt 
Scope . 

6.1 Externes Messsignal verwenden 

Der zweite Kanal der Oszilloskopfunktion kann anstatt des CAN_L-
Signals ein externes Signal zu Mess- und Triggerzwecken abtasten. 
Dieses wird über die BNC-Buchse an der Rückseite zugeführt. 

Für ein externes Messsignal benötigen Sie einen Tastkopf, der nicht 
im Lieferumfang enthalten ist. Einsetzbar ist ein Standardtastkopf 
ohne Zusatzelektronik, der mit der Einstellung x1 betrieben wird. 

Die Spannung eines externen Messsignals darf maximal ±50 V 
betragen. 

Um eine gesonderte Masseverbindung zwischen dem PCAN-Diag 
und dem Messobjekt herzustellen, steht eine Massebuchse (4 mm) 
zur Verfügung. 
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Massebuchse und BNC-Buchse für Tastkopf  

an der Geräterückseite 

Die Verbindung des zweiten Oszilloskopkanals mit dem externen 
Messsignal stellen Sie über folgende Einstellung im PCAN-Diag her: 

Scope  > Settings  > Ch2 source  

Einstellung Messbereich 

Probe (low)  -3 - +15 V 

Probe (high) -10 - +50 V 
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7 Technische Daten 

Versorgung 

Versorgungsspannung Extern über Versorgungsbuchse:  
12 V DC nominell, 8 - 50 V möglich 

Intern durch 4 Batterien/Akkus (Größe Mignon/AA):  
4 x 1,5 V oder 4 x 1,2 V DC 

Hinweis: Das Gerät hat keine Ladefunktion für 
eingelegte Akkus. 

Stromaufnahme Externe Versorgung: 
8 V (min.): 300 mA 
12 V (nom.): 200 mA 
32 V: 83 mA 
50 V (max.): 50 mA 

Batteriebetrieb: 
5 V: 300 mA 

Single-Wire-CAN-
Transceiver (optional) 

7 - 19 V DC 
über D-Sub-Anschluss Pin 1 (optional Pin 9) 

 

CAN 

Standard-Transceiver High-Speed-CAN ISO 11898-2 (PCA82C251) 

Alternative Transceiver 
(auf Anfrage) 

Low-Speed-CAN ISO 11898-3 (TJA1054) 
Single-Wire-CAN SAE J2411 (TH8056/AU5790) 

Terminierung High-Speed-CAN (ISO 11898-2):  
120 Ω zuschaltbar per Software 

Low-Speed-CAN (ISO 11898-3):  
nicht vorhanden 

Single-Wire-CAN (SAE J2411):  
nicht vorhanden 

Galvanische Trennung Auf Anfrage (nur mit High-Speed-CAN-Transceiver) 
 

Anzeige 

Typ OLED 

Auflösung 320 x 240 Pixel 
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Maße 

Größe 103 x 58 x 212 (225 mit BNC-Buchse) mm  
(B x H x L) 

Siehe auch Maßzeichnung Anhang B Seite 36 

Gewicht 400 g (ohne Batterien) 
 

Umgebung 

Betriebstemperatur -20 - +60 °C 

Temperatur für Lagerung 
und Transport 

-40 - +80 °C 

Relative Luftfeuchte 15% - 90%, nicht kondensierend 

EMV EN 61326-1:2006-10 
EC-Direktive 2004/108/EG 
EN 55011 

Schutzart (DIN EN 60529) IP20 
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Anhang A CE-Zertifikat 
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Anhang B Maßzeichnung 

 
Die Abbildung entspricht nicht der Originalgröße;  

Maße für Gehäuse ohne Gummimanschette 
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